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9.1 to support Claro SIP Trunking Service — Issue 1.0

Abstract

These Application Notes describe the steps necessary for configuring Session Initiation
Protocol (SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office Release
9.1 to interoperate with Claro SIP Trunking Service.

The test was performed to verify SIP trunk features including basic calls, call forward (all
calls, busy, no answer), call transfer (blind and consult), conference, and voice mail. The calls
were placed to and from the PSTN with various Avaya endpoints.

Claro SIP Trunking Service provides PSTN access via a SIP trunk between the enterprise and
Claro’s network as an alternative to legacy analog or digital trunks. This approach generally
results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Claro is a member of the Avaya DevConnect Service Provider Program. Information in these
Application Notes has been obtained through DevConnect compliance testing and additional
technical discussions. Testing was conducted via the DevConnect Program at the Avaya
Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the steps necessary for configuring Session Initiation Protocol
(SIP) Trunk Service for an enterprise solution consisting of Avaya IP Office Release 9.1 to
interoperate with Claro SIP Trunking Service.

In the sample configuration, the Avaya IP Office solution consists of Avaya IP Office (hereafter
referred to as IP Office) 500v2 Release 9.1 and various Avaya endpoints, including Avaya
Communicator for Windows, Avaya IP Office Video Softphone and Avaya deskphones,
including SIP, H.323, digital, and analog.

During the interoperability testing, feature test cases were executed to ensure interoperability
between Claro and IP Office.

During the interoperability testing, a VPN connection was used to connect the simulated Avaya
enterprise network to Claro’s network via the public Internet. The connection could also be done
without the use of VPN.

The Claro SIP Trunking Service referenced within these Application Notes is designed for
business customers. Customers using this service with the IP Office solution are able to place
and receive PSTN calls via a broadband WAN connection using the SIP protocol. This
converged network solution is an alternative to traditional PSTN trunks such as analog and/or
ISDN-PRI trunks. This approach generally results in lower cost for the enterprise.

The terms “Service Provider” and “Claro” will be used interchangeable throughout these
Application Notes.

2. General Test Approach and Test Results

The general test approach was to simulate an enterprise site in the Avaya Solution &
Interoperability Test Lab by connecting IP Office to Claro SIP Trunking Service via the public
internet, as depicted in Figure 1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent
to the interoperability of the tested products and their functionalities. DevConnect Compliance
Testing is not intended to substitute full product performance or feature testing performed by
DevConnect members, nor is it to be construed as an endorsement by Avaya of the suitability or
completeness of a DevConnect member’s solution.
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2.1. Interoperability Compliance Testing

To verify SIP trunk interoperability, the following areas were tested for compliance:

e SIP OPTIONS queries and responses.

e Incoming calls from the PSTN were routed to the DID numbers assigned by Claro.
Incoming PSTN calls were terminated to the following endpoints: Avaya 96x0 Series IP
Deskphones (H.323), Avaya 96x1 Series IP Deskphones (H.323), Avaya 1100 Series IP
Deskphones (SIP), Avaya Communicator for Windows, Avaya IP Office Video
Softphone, Avaya 1400 Series Digital Deskphones, Avaya 9500 Series Digital
Deskphones, and analog Deskphones.

e Outgoing calls to the PSTN were routed via Claro’s network to various PSTN

destinations.

Caller ID presentation.

Proper disconnect when the caller abandons the call before the call is answered.
Proper disconnect via normal call termination by the caller or the called parties.
Proper disconnect by the network for calls that are not answered (with voicemail off).
Proper response to busy endpoints.

Proper response/error treatment when dialing invalid PSTN numbers.

Proper Codec negotiation and two way speech-path. (Testing was performed with codecs:
G.711MU, G.711A and G.729A, Claro’s preferred codec order).

No matching codecs.

e Proper early media transmissions.

Voicemail and DTMF tone support (leaving and retrieving voice mail messages from
PSTN phones).

Outbound Toll-Free calls, interacting with IVR (Interactive VVoice Response systems).
Calling number blocking (Privacy).

Call Hold/Resume (long and short duration).

Call Forward (unconditional, busy, no answer).

Blind Call Transfers.

Consultative Call Transfers.

Station Conference.

Mobility twinning of incoming calls to mobile phones.

Simultaneous active calls.

Long duration calls (over one hour).

Proper response/error treatment to all trunks busy.

Proper response/error treatment when disabling SIP connection.

T.38 fax.

G.711 Pass-through fax.

Note: Remote worker was not tested with this solution since the Avaya Session Border
Controller for Enterprise (Avaya SBCE) was not included in the configuration used during the
compliance testing. The Avaya SBCE is a required component for enterprises planning to deploy
Remote Workers.
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Items not supported or not tested included the following:

The SIP REFER method for call redirection was not tested for reasons noted under
Section 2.2.

Inbound toll-free calls, Outbound Toll-Free calls, 911 calls (emergency), “0” calls
(Operator), 0+10 digits calls (Operator Assisted), and 411 calls (Local Directory
Assistance) were not tested.

2.2. Test Results

Interoperability testing of Claro SIP Trunking Service was completed successfully with the
following observations/limitations.

SIP REFER: Calls from the PSTN to IP Office that are re-directed to another PSTN
endpoint by the IP Office user, with REFER enabled in IP Office, did not work properly.
Testing was done with REFER disabled in IP Office, refer to Section 5.4.3.

Caller ID display on Call Forwards to the PSTN: For Calls from the PSTN to IP
Office, that were Forwarded back out to the PSTN, the caller ID number displayed at the
PSTN was always of the first DID number assigned to the SIP Trunk , regardless of the
PSTN number being used to originate the call.

Caller ID display on Mobile Twinning: For Mobile Twinning calls, the Caller ID
display at the Mobile/cellular station was always of the first DID number assigned to the
SIP Trunk, regardless of the PSTN number being used to originate the call.

No matching codec on outbound calls: If an unsupported audio codec is received by
Claro on the SIP Trunk (e.g., 722-64K), Claro will respond with “500 Server Internal
Error” instead of “488 Not Acceptable Here”, and the user will hear re-order. This issue
does not have any user impact, it is listed here simply as an observation.

2.3. Support

For support on Claro systems visit the corporate Web page at:
http://www.claro.com.do/wps/portal/do/sc/empresas.

Avaya customers may obtain documentation and support for Avaya products by visiting
http://support.avaya.com. Alternatively, in the United States, (866) GO-AVAYA (866-462-8292)

provides access to overall sales and service support menus.
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3. Reference Configuration

Figure 1 illustrates the test configuration used for the DevConnect compliance testing. The test
configuration simulates an enterprise site with an Avaya SIP-enabled enterprise solution
connected to the Claro SIP Trunking Service through the public Internet.

The Avaya components used to create the simulated enterprise customer site includes:
e Avaya IP Office 500v2.

Avaya Voicemail Pro for IP Office.

Avaya 96x0 Series H.323 IP Deskphones.

Avaya 96x1 Series H.323 IP Deskphones.

Avaya 1100 Series SIP IP Deskphones.

Avaya Communicator for Windows Softphone.

Avaya IP Office Video Softphone.

Avaya 1408 Digital Deskphones.

Avaya 9508 Digital Deskphones.

Analog Deskphone.

Fax Machines.

The enterprise site contains the Avaya IP Office 500v2 with analog and digital extension
expansion modules, as well as a VCM®64 (Voice Compression Module) for supporting VolP
codecs. The LANL1 port of IP Office is connected to the enterprise LAN (private IP network)
while the LAN2 port is connected to Claro’s network via a VPN connection. Endpoints include
Avaya 96x0 and 96x1 Series IP Deskphones (with H.323 firmware), Avaya 1100 Series IP
Deskphones (with SIP firmware), Avaya 1408 and 9508 Digital Deskphones, Analog
Deskphones, Fax Machines, and a PC running Avaya Communicator for Windows and Avaya IP
Office Video Softphones. The site also has a Windows PC running Avaya IP Office Manager to
configure and administer the IP Office system, and Avaya Voicemail Pro providing voice
messaging service to the IP Office users. Mobile Twinning is configured for some of the IP
Office users so that calls to these user’s extensions will also ring and can be answered at the
configured mobile phones.

For the purposes of the compliance test, users dialed a short code of 9 + N digits to make calls
across the SIP trunk to the PSTN via Claro’s network. The short code 9 was stripped off by IP
Office but the remaining “N” digits were sent unaltered to the network. Refer to Section 5.6.

In an actual customer configuration, the enterprise site may include additional network
components between the service provider and the IP Office system, such as firewalls. A
complete discussion of the configuration of these devices is beyond the scope of these
Application Notes. However, it should be noted that all SIP and RTP traffic between the service
provider and the IP Office system must be allowed to pass through these devices.
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For confidentiality and privacy purposes, public IP addresses, user names, passwords and DID
numbers used during the compliance testing have been masked.

Service Provider

SIP Proxy: 172.31.20.16

-
B2 VPN Gateway

Gateway: 192.168.214.6

Internet

-
Simulated Enterprise
Domain: avaya.lab.com

DIDs: 123-456-9226, 9254

I 'PSec Tunnel

j VPN Firewall

10.10.157.131

i Avaya 96x0 Series
IP Deskphones

LAN2
172.16.5.199

LAN1
172.16.5.60

Avaya P Office 500 V2.
Rel 9.1

Desktop PC

Avaya 96x1 Series
IP Deskphones

(H.323) (H.323)
- Avaya IP Office Manager
- Avaya Voice Mail Pro Client
338 - Avaya Communicator for Windows (SIP) Avaya 1100
Analog - Avaya IP Office Video Softphone (SIP) Series IP
Deskphones ~_Avaya 9508, 1408 Desklphones
Digital Deskphones (SIP)
\ 7y
Figure 1: Avaya Interoperability Test Lab Configuration
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4. Equipment and Software Validated
The following equipment and software were used for the sample configuration provided:

Equipment/Software

| Release/Version

Avaya
Avaya IP Office 500v2 9.1.1.0 Build 10
Avaya IP Office DIG DCPx16 V2 9.1.1.0 Build 10
Avaya IP Office Manager 9.1.1.0 Build 10
Avaya Voicemail Pro Client 9.1.1.0 Build 3
Avaya 96x0 Series IP Deskphones (H.323) Avaya one-X® Deskphone Edition
S3.230A

Avaya 96x1 Series IP Deskphones (H.323)

Avaya one-X® Deskphone H.323
Version 6.4014

Avaya 1140E IP Deskphones (SIP)

SIP1140e Ver. 04.04.18.00

Avaya Communicator for Windows 2.0.3.30
Avaya IP Office Video Softphone 3.2.3.49 68975
Avaya Digital Deskphones 1408 40.0
Avaya Digital Deskphones 9508 0.55
Lucent Analog Phone -
Claro
IMS Huawei CSCF-BCF \V100R010C0O0SPC100
SBC Huawei SessionEngine2600 VV200RO09ENGC30SPC100

Note: Compliance Testing is applicable when the tested solution is deployed with a standalone
IP Office 500v2 and also when deployed with all configurations of IP Office Server Edition

without T.38 Fax Service.
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5. Configure Avaya IP Office

IP Office is configured through the Avaya IP Office Manager application. From the PC running
Avaya IP Office Manager, select Start - Programs - IP Office - Manager to launch the
application. A screen that includes the following may be displayed.

WELCOME to IP Office Administration

What would you like to do?

Create an Offline Configuration

| Open Configuration from Systeml

Read a Configuration from File

Select Open Configuration from System. If the above screen does not appear, the configuration
may be alternatively opened by navigating to File - Open Configuration at the top of the
Avaya IP Office Manager window. Select the proper IP Office system from the pop-up window
and log in with the appropriate credentials.

The appearance of the Avaya IP Office Manager can be customized using the View menu. In the
screens presented in this document, the View menu was configured to show the Navigation pane
on the left side, omit the Group pane in the center, and show the Details pane on the right side.
Since the Group pane has been omitted, its content is shown as submenus in the Navigation
pane. These panes (Navigation, Group and Details) will be referenced throughout the IP Office
configuration. All licensing and feature configuration that is not directly related to the interface
with the service provider is assumed to already be in place.

In the sample configuration, the MAC address 00E00706530F was used as the system name. All
navigation described in the following sections (e.g., License = SIP Trunk Channels) appears
as submenus underneath the system name 00E00706530F in the Navigation Pane.
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5.1. Licensing and Physical Hardware

The configuration and features described in these Application Notes require IP Office to be
licensed appropriately. If a desired feature is not enabled or there is insufficient capacity, contact
an authorized Avaya sales representative.

To verify that there is a SIP trunk channels license with sufficient capacity; click License in the
Navigation pane. Confirm a valid license with sufficient Instances (trunk channels) in the
Details pane. Note that the full License Key in the screen below is not shown for security

purposes.

| -

Corttel Unt (3)

i & Baensen 37)
3§ User32)
+- B Group 1)
9% Snon Code 185)
B servce )
oo RAS Q1)
4 s Incoming Call Route (8]
WAN Pont 0
& Deectory )
Time Profile 1)
i @ Frewall Profie (1)
oute 4

W Tunne 0

B User Rights 3)
W ARS ()

S Locatien )
Q8 Auahorzstion Code 10)

# RAS Location Reguest ()

|| Lxcense ‘Remote Server
Licenze Mode License Normal

Licensed Yersicn E S |

Serial Namibet (A00)

PLDS Host ID

PLDS File Status Not Presant £

LU=

Festure Lacense Key batances Status Expiry Date Source
P00 Upgrade Standard 1 Profeas.. QuHgn?&A6.. 255 Obsttete Never ADE Nodal
P00 Vorce Networking Channels  JaHLHAVEGD 4 Vald Never ALE Nodal
|58 Trunk Channels BCQeGBYIVs.. 255 Valid Hiever ADS Nodel |
VR IP Edensiens S. 255 Dbisciete Never ALC Nodel
P50) Uriversal PRI (Additional cha 255 Valid Never ADE Nodal
RAS LRQ Support (Rapd Respone)  § 255 Valid Never ADG Nodal
P OMice Dexder Suppont - Standar. 255 Vald Never AR Nodal
P Office Dester Suppont - Profess 255 Valid Nmoer ADI Nodal
P Dffice Disteidntee Suppent - Stan.. SASEEIOSE N 155 Valid Nevwr ADI Nedal
P Office Dutribator Suppont - Prof... LIFZqB6XeQ 15 Vald Never ADE Nodal
UMS Web Services POl A 255 Valwd Never ADI Nodel
Customer Service Agent jlshicAADeD.. 2155 Obscdete Never ALG Nodal
1600 Senes Phones Uskn2Per3dS,. 255 vahd Neves Al Nodal
Third Party AP| Lan7QTEROAI.. 155 Valid Never ADI Nodal
Sottware Upgrade 239 chiWFr Ve 1 Vald Never ADS Nodal
ome-X Portal for 1P Office By@FbtsSiGd 255 Valid Never ADE Nodal
Avays IP enclpeinty jTBvedgl 7. 255 Valid Newer ADE Nodal
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To view the physical hardware comprising IP Office, expand the components under the Control
Unit in the Navigation pane. In the sample configuration, the Avaya IP Office 500v2 is
equipped with analog and digital extension expansion modules, as well as a VCM64 (Voice
Compression Module) for supporting VolP codecs. An IP Office hardware configuration with a
VVCM component is necessary to support SIP Trunking Services.

To view the details of the component, select the component in the Navigation pane. The
following screen shows the details of the Avaya IP 500 V2.

IP Offices

-
-
i

IP 500 V2

#- & BOOTP (3)

%P System (1)
¢ % D0E00706530F
-1 Line (4)
|- Control Unit (4)
=+ 1 1P 500 V2
= 2VCMe4/PRID U
=+ 3 PHOMES
= 6 DIG DCPxlb V2
+-4 Extension (37)

0§ User(32)

-1 Group (1)
+-@% Shert Code (55)
e B Service ([0
ol RAS (1)

..... @ WAM Port (0]

----- 22 Directory (0)

----- £ Time Profile (0)
@@ Firewall Profile (1)
+-Jfll IP Route (4)

----- B Account Code (0)
----- % License (75)

----- @ Tunnel (0)

+-§3 User Rights (8)
4 ARS (1)

..... 53 Location m

+¢ Incoming Call Route (3)

..... " RAS Location Request (0)

----- ﬁ Authorization Code (0)

Device Mumber

Unit Type

Version

Serial Mumber

Unit IP Address
Interconnect Mumber

Module Mumber

1

IP 500 V2

9.1100.10

172.16.5.60

0

Control Unit
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5.2. System

Configure the necessary system settings. In an IP Office system, the LANZ2 tab settings
correspond to the IP Office WAN port (public network side) and the LAN1 tab settings
correspond to the LAN port (private network side).

5.2.1. System — LAN2 Tab

In the sample configuration, the IP Office WAN port was used to connect to Claro. The LAN2
settings correspond to the WAN port on the Avaya IP Office 500v2. To access the LAN2
settings, first navigate to System - <Name>, where <Name> is the system name assigned to IP
Office. In the case of the compliance test, the system name is the MAC address 00E00706530F.
Next, navigate to the LAN2 - LAN Settings tab in the Details pane. Set the IP Address field
to a private IP address on the enterprise LAN side (private IP network). Set the IP Mask field to
the mask used on the enterprise LAN side (private IP network). All other parameters should be
set to default or according to customer requirements. Click OK to commit (not shown).

Note: A private IP address on the enterprise LAN side (private IP network) was used instead of a
public IP address, since a VPN connection was used to connect to Claro’s network. When a VPN
connection is not used, a public IP address, instead of a private IP address, is assigned to LAN2.

-

IP Offices =

00E00706530F

=& BOOTP (3)

447 Operator (] | Systern | LANL I LAN2Z | DNS | Voicernail | Telephony | Directory Services | Systern Events | SMTP

----- $8 WAM Port (0)

----- @ Directory (0)

----- 17 Time Profile [0)

{8} Firewall Profile (1)
-Jill IP Route (4)

----- @l Account Code (0)

----- B License (75)

----- % Tunnel (0]

+-§5 User Rights (8)

- ARS (1)

----- " RAS Location Request (0)
----- & Location (0)

----- ﬂ Authorization Code (0)

=-%=7 QOEO0706530F |LAN Settings IVoIP | NetworkTopologﬂ
—’: System (1)
¢ .=y OOEDDT06530F IP Address 172 16 5 199
H-T9 Line (4]
+ = Control Unit (4) IP Mask 255 255 255 0
+$ Extension (37) .
0§ User G2) Primary Trans. IP Address 0 0 0 0
+ﬂ Group (1) Firewall Profile [<None> 'J
+-@% Short Code (65)
B Senvice (0) RIP Mode (None ~|
ok, RAS (1)
+® Incoming Call Route (3) [C] Enable NAT

-

Number Of DHCP IP Addresses |1 -
DHCP Mode

0 Server () Client ) Dialin @ @ Disabled Advanced
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On the VVoIP tab in the Details pane, configure the following parameters:
e Check the SIP Trunks Enable box to enable the configuration of SIP trunks.
e The RTP Port Number Range can be customized to a specific range of receive ports for
RTP media. Based on this setting, IP Office would request RTP media be sent to a UDP
port in the configurable range for calls using LANZ2.

Fie Ede  Viem Tookh Hep
|
ti-4 2o s v o2E
O0EDITOSSIOF - DOEDOMOES30F -
o .\“l
0 R 8001 i P T - = = SRV PSR vy P Ep
LS Geonst system [ Lars [0 Jons | veicama | Tolephany | Doactory Semces | System Everts | TP | SMOR. | Twwnnng [ VM| Codecs
= 0 COEOTOESIF LAN Settings | Vo | Netwerk Tepolegy
JOEDS Y U] H323 Gateboepet Enable
o ine Astec-crets Extn Ao creshe Uint HIZ3 Rarmcts Ests Enabiie
¥ Cortool Unat (8)
¥4 Edenson (37) i
O W)
R Group 1)
B Sheet Cose (83}
@ senvicem) [ SF Registrar Enatle
; x l‘:? a AuteOasts Etn/lhar WP Remate Extn Tnable
coming Call Route (€)
WAN Port )
o Opectory )
L. Time Pacve 1) upe : 15060 3080
i @ Frewal Profie (1)
[ IP Route (4) 1P 060 050
& Account Code )
W Licene (75) 5201 208
& Tunnel 0
B User Rights (8] 15
4 ARSQ)
# RAS Location aguest 1) |
5 Location (0) RTP
R Zuthoraation Code 1) Port Numbes Range
Nnimism o 2 Mamum S50
Part Number Range (NAT)
Mnimum 40152 = Maimum SINE 3
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Scroll down the page.

e Inthe RTP Keepalives section, set the Scope to RTP. Set the Periodic timeout to 30
and the Initial keepalives parameter to Enabled. These settings will cause IP Office to
send a RTP keepalive packet starting at the time of initial connection and every 30
seconds thereafter if no other RTP traffic is present. This facilitates the flow of media in
cases where each end of the connection is waiting to see media from the other, as well as
helping to keep firewall ports open for the duration of the call.

e In the DiffServ Settings section, IP Office can also be configured to mark the
Differentiated Services Code Point (DSCP) in the IP Header with specific values to
support Quality of Services policies for both signaling and media. The DSCP field is the
value used for media and the SIG DSCP is the value used for signaling. The specific
values used for the compliance test are shown in the example below and are also the
default values. For a customer installation, if the default values are not sufficient,
appropriate values will be provided by the customer.

e All other parameters should be set to default or according to customer requirements.

e Click OK to commit (not shown).

[= DRSNS
Syviem LG DS | Voscemail | Telephomy | Divectony Senaces | System fvents | SMTR - SMDR  Twnnng | WOM  © Codecy
LAl )«rq;'\exn Toposqgy
Mimmum 10157 5 Masirum SIM6
Port Number Range (NAT
Mismum L E16 2 Massrvom S3246
7! Ermable RTCP Monroeng en Poct 5005
RICP collector B address for phomes
Keepalres
cope RIp w  Penodic tamecur
lretial keepalromn Eratied v
D Sery Setting
o = DACPOMey B Video DSCPIHey ¥C S OSCP Mask (Hey) B8 =0 OSCP (Mex)
% > Do & I Vides DSCP 63 S DESCP Mask H 96 DSCP
DHCP '..l"lh'_)'
Orarary St Specdic Ogtion Number (S50M) 176
Secondary Site Specéic Optiom Number (SSON
VLAN Net Prevert -
1100 Vosce VLAN Ste Specific Option Number (SS0N) 152
1100 Vowce VLAN IDs
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On the Network Topology tab in the Details pane, configure the following parameters:
e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. Since no firewall or network address translation (NAT) device was used

between IP Office and Claro, the parameter was set to Open Internet.

e Set the Binding Refresh Time (seconds) to a desired value, the value of 300 (or every 5
minutes) was used during the compliance testing. This value is used to determine the

frequency that IP Office will send OPTIONS heartbeat to the service provider.

e Set Public IP Address to the IP address of the IP Office WAN port (LAN2) assigned

above.

e Inthe Public Port section, next to the transport protocol UDP, select the UDP port on

which IP Office will listen.
e All other parameters should be set to default or according to customer requirements.
e Click OK to commit (not shown).

IP Offices

00E00706530F

=& BOOTP (3)
+-¢% Operator (3)
=7 O0EQ0706530F
=) System (1)
=7 OEDOT06530F
H-T4 Line (4)
+ = Control Unit (4)
-4 Extension (37)
- User(32)
-4k Group (1)

+@ Incoming Call Route (3)
----- £8 WAN Port (0)

----- @& Directory (0)

.1 Time Profile (0)
-} Firewall Profile (1)
+-[fll IP Route (4)

----- 8 Account Code (0]
----- % License (75)

""" & Tunnel (0)

+-§5 User Rights (8)
+( ARS (1)

----- & Location (0)
----- ﬁ Authorization Code (0]

| System | LANL | LANZ | DNS | Voicemail | Telephony | Directory Services | System Events | SMTP | SMDR | Twinning | VCM

----- " RAS Location Request (0)

[ LAN Settings | voIp | Network Topology |

Metwork Topelogy Discovery
STUN Server Address

Firewall/NAT Type
Binding Refresh Time (seconds)

Public IP Address

199

Public Port

upp 5060 e
TCP 5060 =
LS 0 =

Run 5TUN on startup

3478 =

Cancel

Note: In the compliance test, the LANL1 interface was used to connect IP Office to the enterprise
site IP network (private network). The LANL1 interface configuration is not directly relevant to
the interface with the Claro SIP Trunking Service, and therefore is not described in these

Application Notes.
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5.2.2. System - Telephony Tab

To access the System Telephony settings, navigate to the Telephony - Telephony tab in
the Details pane. Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call
forwarding and call transfer to the PSTN. If for security reasons, incoming calls should not
be allowed to transfer back to the PSTN, then leave this setting checked. All other parameters
should be set to default or according to customer requirements. Click OK to commit (not
shown).

7K B0OTP 3) em | LANL | LANZ | DNS | Wescermail| Telephonyy | Dectory Seevices | System Events | SMTP | SMOR. | Twine VCM | Codecs | Vol® Secur
g
# (= Operator 31 { e — . —— -
= [ DoezaTnes soF Pack & Page| Tones & Musc | fing Tenes [ M | CaliLog | T8
=% System (1)
“w ODEXT085 J0F Analogue Bitensions Compandng Law
&1 Line 3) Switch Line
Contrel Ut (8) Defadt Outside Call Sequence Noemad -
¥ My Extenyion 37) P
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5.2.3. System - Twinning Tab

To view or change the System Twinning settings, navigate to the Twinning tab in the Details
pane as shown in the following screen. The Send original calling party information for
Mobile Twinning box is not checked in the sample configuration, and the Calling party

information for Mobile Twinning is left blank. Click OK to commit (not shown).

o R
= Operator 3}
o 00E00T085308

IP Offices

800TP 3)

LT Line 3)
Control Unit |4}

b Edenscn (37)
i wed?
v G Geoup (1

+ 9% Short Code (85)

Service 9)

- RAS (1
' 0 Incoming Cah Route 15)

W wean Pont (0)
=% Directery )
Time Profile (0

i & Firewall Profile (1)
+ P Route |4)

&8 Acceunt Code (U

|
# RAS Location Reguest ) |

&% Locaton (0)
B4 Authorization Code 10

System J LANL  LANZ | DS | Voscemal ; Teleghony | Dreciory Services [ Syaten Events - SMTP | SMODR ‘a(M Codt(si Vol Secunty |

Serd coaginal calbng party information for Moksie Twanning

Calling party wformation for
Moble Twrrng
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5.2.4. System — Codecs Tab

For Codecs settings, navigate to the System (1) = 00E00706530F in the Navigation pane,
select the Codecs tab and configure the following parameters:
e Inthe Codecs tab of the Details pane, select or enter 101 for RFC2833 Default Payload.
This setting was recommended by Claro for use with out-band DTMF tone transmissions.
e For codec selection, select the codecs and codec order of preference on the right, under
the Selected column. The Default Codec Selection area enables the codec preference
order to be configured on a system-wide basis. The buttons between the two lists can be
used to move codecs between the Unused and Selected lists, and to change the order of
the codecs in the Selected codecs list. By default, all IP phones (SIP and H.323) will use
the system default codec selection shown here, unless configured otherwise for a specific
extension. The example below shows the codecs used for IP phones (SIP and H.323), the
system’s default codecs and order was used.

System | LAND LAND | DINE Volcemak  Telephony Deectory Senices | Symem Events - SMTP | SMOR | Twinoing | ¥OM | Lodecs

RFC2E33 Detsult Fayfosd 101 ;
Avadsbie Codecs odac Sekaction

VoiP Secusty | Contact Center

Note: The codec selections defined under this section (System — Codecs Tab) are the codecs
selected for the IP phones/extensions. The codec selections defined under Section 5.4.6 (SIP
Line — VVoIP tab) are the codecs selected for the SIP Line (Trunk).
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5.3. IP Route

Create an IP route to specify the IP address of the gateway or router where IP Office needs to
send the packets in order to route calls to Claro’s network (if located in a different subnet).

To create an IP route, on the left Navigation pane, right-click on IP Route. Select New (not

shown).

e Set IP Address to 172.31.20.0 (IP subnet assigned to Claro’s SIP Proxy).

e Setthe IP Mask to 255.255.255.0 (IP Mask assigned to Claro’s SIP Proxy).

e Set Gateway IP Address to the IP address of the default router for the public network
where IP Office is connected. Gateway IP Address 172.16.5.200 was used in the sample
configuration, which correspond to the enterprise LAN side (private IP network) IP

address assigned to the VPN firewall. Refer to Figure 1.
e Set Destination to LAN2 from the drop-down list.
e Click the OK to commit (not shown).

43 Incoming Call Route (3)
----- E8 WAN Port (0)
--a4g [hirectory (0]
-7 Time Profile (0)
+-{4} Firewall Profile (1)
=-Jill IP Route (4)

= 192.168.188.0

----- Bl 192.168.99.0

----- | Account Code (0)

----- % License (75)

----- W& Tunnel (0}

+-§q User Rights (8)

+K ARS (1)

----- " RAS Location Request (0)
----- &8 Location (0)

----- ﬁ Authorization Code (0)

IP Offices = 172.31.20.0
- R BOOTP (3) IP Route
i Operator (3)
=% 00E00706530F IP Address 2.3 .10
! Systemn (1)
- = 00E00706530F P Mask 250
#-T9 Line (4) Gateway IP Address 172 16 5 200
-2 Control Unit (4)
+$ Extension (37) Destination LANZ
i-§  User(32)
+,u Group (1) Metric 0
+-8) Short Code (65)
..... @ Service (0) Praxy ARP
+-als RAS (1)
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5.4. SIP Line

A SIP Line is needed to establish the SIP connection between IP Office and Claro SIP Trunking
Service. The recommended method for configuring a SIP Line is to use the template associated
with these Application Notes. The template is an .xml file that can be used by Avaya IP Office
Manager to create a SIP Line. Follow the steps in Sections 5.4.1 and 5.4.2 to create the SIP Line
from the template.

Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP trunk Registration Credentials.

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary
after the SIP Line is created via the template. The resulting SIP Line data can be verified against
the manual configuration shown in Sections 5.4.3 to 5.4.7.

Alternatively, a SIP Line can be created manually. To do so, right-click on Line in the
Navigation pane and select New => SIP Line. Then, follow the steps outlined in Sections 5.4.3
to 5.4.7

5.4.1. Importing a SIP Line Template

Note — DevConnect generated SIP Line templates are always exported in an XML format. These
XML templates do not include sensitive customer specific information and are therefore suitable
for distribution. The XML format templates can be used to create SIP trunks on both IP Office
Standard Edition (500v2) and IP Office Server Edition systems. Alternatively, binary templates
may be generated. However, binary templates include all the configuration parameters of the
Trunk, including sensitive customer specific information. Therefore, binary templates should
only be used for cloning trunks within a specific customer’s environment.

1. Copy a previously created template file to a location (e.g., C:\Temp) on the same computer
where IP Office Manager is installed. By default, the template file name will have the format
AF_<user supplied text>_SIPTrunk.xml, where the <user supplied text> portion is entered
during template file creation.

Note — If necessary, the <user supplied text> portion of the template file name may be
modified, however the AF_<user supplied text>_SIPTrunk.xml format of the file name must
be maintained. For example, an original template file AF_TEST _SIPTrunk.xml could be
changed to AF_Testl SIPTrunk.xml. The template file name is selected in Section 5.4.2,
Step 2, to create a new SIP Line.
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2. Verify that Template Options are enabled in IP Office Manager. In IP Office Manager,
navigate to File > Preferences. Inthe IP Office Manager Preferences window that
appears, select the Visual Preferences tab. Check the box next to Enable Template
Options. Click OK.

s =\
%t"| IP Office Manager Preferences o —— i f— @i—hj

| Preferences | Directories | Discovery | Visual Preferences | Security | ‘u‘alidation|

Icon Size [Small v]
[7] Multiline Tabs
| Enable Template Optiunsl
Enable Ternplate Creation

5 o [ cma |[ v |

3. Import the template into IP Office Manager. From IP Office Manager, select Tools -
Import Templates in Manager.

File Edit View | Tools | Help
2= o] E Extension Renumber...
O0E0OT06530F Line Renurnber...
Connect To..
IP Office
Export 3
“ BOOTP (3) SCHM Service User Management (olf 738 Fax
i+ Operator (3)
EI"-’-_“‘.J O0EOO706530F Busy on Held Validation
[H-*30 Systern (1)
=17 Line (3) MS5M Configuration
Pk Print Button Labels stem Default
| Import Templates in Manager
&-“= Control Unit (4) [ [G.711 ALAW 64K
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4. A folder browser will open. Select the directory used in Step 1 to store the template(s) (e.g.,

C:\Temp).

Browse For Folder ﬁ

Select a folder to import templates from -

> 1 ProgramData
» L) SUPPORT
» . swiools

» L swwork

. Temnp

/ tmp
o Trilegy

» ) Users w7
4 1 3

[ oK ]I Cancel J

In the reference configuration, template files AF_Claro Dominican Republic_ SIPTrunk.xml
was imported. The template files are automatically copied into the IP Office default template
location, C:\Program Files\Avaya\lP Office\Manager\Templates.

5. After the import is complete, a final import status pop-up window will open stating success
or failure. Click OK.

s B
Template Provisioning ‘&J

( . Successfully imported templates to IP Office Manager from
&P C\Temp
| ok |
o =
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Note —Windows 7 (and later) locks the Avaya IP Office 9.1 \Templates directory, and it cannot
be viewed. To enable browsing of the \Templates directory, open Windows Explorer, navigate
to C:\Program Files\Avaya\lP Office\Manager\Templates (or C:\Program Files
(x86)\Avaya\lP Office\Manager\Templates), and then click on the Compatibility files option
shown below. The \Templates directory and its contents can then be viewed.

4—“" » Computer » Avaya eS0E(CI) » Program Files bG] » Avays » ¥ Office » Manager »
Orgenis = Jochude inAblary = Shire weth © Bum Compatibdity liles Hew lolder

e Pherria : ) Type
L I de-DE Fily Feisher
B Dowriceds b enUs Fite fcider
MM Fibe Yokdes
4 Livanes L fFR 271/205 80 AN File ‘oicher
* Documents b IPSET-LNESTIVL.CTM 172072004 1040 AM  Filn Folet
o Mo by 13208800 AN File foider
o Pictures L LMGreeting 27372005 800 A0 Fike toidey
B videos 4 MemonyCards /015 £200 AN File folsher
b oalar IAANLYEL0 A File doider
1™ Computer L Phonelmages /2977018 1043 AN File falday
B Aoy eS0E T L pt-BR L3NS E00 AN File tolder

@ o v AppData » Local » VirtualStore » Program Files (xB6) » Awvaya » IP Office » Manager »
© File Edit View Tools Help
Organize » Include in library = Share with « Burn Mew folder
-~
<k Favorites Name Date modified Type
Bl Desktop . Templates 2/10/201511:46 AM  File folder

'm.vCunpm-.Aw,bnSOS(GJoboynﬂ-uwayab'Oﬂhbonm
| Hie Bt View Took Help

Organge »  Includeinliovary = Shaewith = fum  Compatitidityfiles  Mew folder N .| 0 |
¢ Favortes 2 Mame ' Cate moded Type
I Desitop = AF_Claro Dorrinican Republic_SIPTrunleml ARSI PM IML Dotumess 0z
B Dewnioads
. Recent Maces
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5.4.2. Creating a SIP Trunk from an XML Template

1. To create the SIP Trunk from a template, right-click on Line in the Navigation pane, and
select New SIP Trunk from Template.

IP Offices =
- R BOOTP (3) 'SIP Line|Transport [SIP URI| VoIP 738
[#H-g# Operator (3) [
=22 00E007( 1 New 5
G550 Syst
= '::f m ﬂ Mew SIP Trunk from Template
_____ : ][] Create SIP Trunk Template giay
]y 1
""" w1 Y Cut Ctrl+X
W2 Conl LAWY
W-dy Exte 2 COPY Ctrl+C 54K
EEI---a Use Paste Ctrl+V a) 8K
-l Grof - ] GK3 |
Delet Ctrl+ Del
@K sho| 1 DIt e
..... @ Sepd v Validate
D'"% RAS Connect To... Ctrl+T
-4 Inco .
_____ Eﬂ WA Mew from Template (Binary)
----- 25 Dire Export as Ternplate (Binary)
----- £ Time Profile 10 I |
o o S

2. In the subsequent Template Type Selection pop-up window, from the Service Provider
pull-down menu, select the XML template name from Section 5.4.1. Click Create new SIP
Trunk.

Note — The drop down menu will display the <user supplied text> part of the template file name
(see Section 5.4.1). If the Display All box is checked, then the full template file name is
displayed.

" Template Type Selection o . o S
Locale United States (LIS English)
Service Provider |Claro Dominican Republic v] ] Display &l

Create new SIP Trunk Cancel
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The newly created SIP Line will appear in the Navigation pane (e.g., SIP Line 17).

IP Offices

#-R BOOTP (3)

4;_...-;:1 Operator (3)

= -3 0DE0OT06530F
'i'"'!'"’" System (1)

—-T4 Line (3)

It is important that the SIP Line configuration be reviewed and updated if necessary after the SIP
Line is created via the template. The resulting SIP Line data can be verified against the manual
configuration shown in Sections 5.4.3 to 5.4.7.
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5.4.3.
On the

SIP Line = SIP Line Tab

SIP Line tab in the Details pane, configure or verify the parameters as shown below.
Leave the ITSP Domain Name blank. Note that if this field is left blank, IP Office
inserts the far end's ITSP Proxy Address from the Transport tab as the ITSP Domain in
the SIP messaging.

Verify that URI Type is set to SIP.

Verify that In Service box is checked, which is the default value. This makes the trunk
available to incoming and outgoing calls.

Verify that Check OOS box is checked, the default value. IP Office will use the SIP
OPTIONS method to periodically check the SIP Line. The time between SIP OPTIONS
sent by IP Office will use the Binding Refresh Time for LANZ2, as shown in Section
5.2.1.

Verify that Refresh Method is set to Auto.

Verify that Timer (seconds) is set to On Demand.

Set Send Caller ID to Diversion Header.

Under Redirect and Transfer, set Incoming Supervised REFER and Outgoing
Supervised REFER to Never (Refer to Sections 2.1 and 2.2).

All other parameters should be set to default or according to customer requirements.
Click OK to commit (not shown).

E SIP Line - Line 17

rampoct| SO URI VIR [138 Fa| SIP Crudentisns | SIP Advanced| Enginesing

Line Nurrbes w 2 In Service v

TSP Domaim Name | Check D05 v

URI Type o - Session Tamers

Location Clouvd - Refresh Method At =
Tener (seconds) On Demand
Prefa forwarding and Twinning
Natona! Prefu Onigrater nussiber
i Incoming Cab Route (8 ey T -
WAN Port (D) eermational Prefe
" [irectory (0)
Lo Time Profie (0 Country Code Redirect snd Transfes
+ Firemall Protile {3 ) "
@ ,2 o 73} S Nerme Priority Gyvtem Detauit = Icoming Supervized KEFER Rever -
Description Outgaing Supervised REFER Hever -

Send 302 Moved Temnpanely

Outguing Bind REFER
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5.4.4. SIP Line - Transport Tab

Select the Transport tab. Set or verify the parameters as shown below.

e Set ITSP Proxy Address to 172.31.20.16, the IP address of Claro’s SIP Proxy.

e Set Layer 4 Protocol to UDP.

e Set Use Network Topology Info to LAN2. The LAN2 settings correspond to the WAN
port on the Avaya IP Office 500v2, used by the SIP Line to access the far-end, configured
in Section 5.2.1.

e Set the Send Port to 5060.

e Default values may be used for all other parameters.

e Click OK to commit (not shown).

IP Offices | = SIP Line -Line 17

@& BOOTP @) 'SIP Ling] Transport [SIP URI|VolP | T38 Fax|SIP Credentials|SIP Advanced| Engineering

[H-4{% Operator (3

[=1-%=¢ 00E00706530F | ITSP Proxy Address 172.31.20.16 |

MNetwork Configuration

Layer 4 Protocol ’UDP v] Send Port 3060 | -

Use Network Topology Info [LAN 2 v] 5060

2 Control Unit (4)
-4 Extension (37) Explicit DNS Server(s) 0 0 0 0 0 0 0 0
B User (32)

[J---ﬂ Group (1) Calls Route via Registrar

(-@% Short Code (65)

-4 Service (0)

E-of; RAS (1)

-4 Incoming Call Route (3)
- §@ WAN Port (0)

a4 Directory (0)

£ Time Profile (0)

G- Firewall Profile (1)

& Jill IP Route (4)

-l Account Code (0)

- License (75)

- Tunnel (0)

E-§q User Rights (8)

B ARS (1)

- RAS Location Request (0]
@ Location (0)

'm Authorization Code (0]

Separate Registrar
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5.4.5. SIP Line - SIP URI Tab

A SIP URI entry needs to be created to match each incoming 